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Copyright Notice

Copyright © 1997 Play  Byte Software Inc.  All rights reserved.

The user of this product shall be entitled to use the product for their personal use, but shall not be entitled
to sell or transfer reproduction of the software, manual or related materials of any other parties in any
way, not to rent or lease the product to others without the prior written permission of Play  Byte Software
Inc.

Trademarks

“MICROSOFT”, “WINDOWS”  and “MS-DOS”  are trademarks of the Microsoft Corporation, registered
in the United States of America and in other countries.

All other product names which may be referred to in this manual are registered trademarks of their
respective owners.
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FOREWORD

Hi, fellow gamers,

Welcome to “DR. DRAGO’S MADCAP CHASE”! Before we start, let’s go through the all-important  pre-
game check list. Is the fridge well stocked with snacks and drinks? Is the couch moved in front of the
monitor? Friends all gathered around and raring to go? Great, then you’re all set for a new computer
games experience!

In creating D.D.M.C., it was our aim to capture all the excitement, fun and thrills that make an evening
with friends and a good board game so memorable, and still have the winner boasting days later about
his “great victory”.

But this time you’ll be playing a computer game, with all the advantages that offers. We’ve designed the
game-play system to encourage group playing sessions; and we’ve found that even people who’ve
never played a computer game before suddenly find themselves hooked on the excitement of chasing
fame and fortune in this mad-cap chase round Europe. Constantly on the run from Dr. Drago, you’ll be
trying to outwit your rivals and beat them to the all-important winning post - if only by a whisker!

You’ll find that the more you play the game, the more new tactics, strategies and dirty tricks you’ll come
up with to make sure you win. You’ll soon discover that D.D.M.C. is unlike any game you’ve ever played
before!

Have fun!

Your Play Byte Team
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INSTALLATION

Note!

On the game CD you’ll find a file called README.WRI. This contains important advice that we couldn’t
fit into this manual. Please read this file carefully!

Technical Requirements
In order to play D.D.M.C., you will need a PC with at least an 80386 processor with a clock speed of 33
MHz, 4 MB RAM and a VGA graphics card with 256 colours at a minimum resolution of 640 x 480. You’ll
also need the corresponding Windows driver and a CD-ROM drive.

In addition, your computer must be running MS-Windows 95, MS-Windows version 3.1 or higher.

In order to ensure all the graphics and animations run smoothly, we recommend an 80486 PC with 33
MHz and 8 MB RAM.

A Windows supported sound card and a joypad or joystick will also make life much easier.

Depending how much RAM you have in your PC, it may be necessary to configure virtual memory under
Windows.

For example, if your PC only has 4 MB RAM, then you should set the virtual RAM to a minimum of 8 MB.
Since the required amount of actually available RAM is dependent on how many programs are running
at the same time, you may  have to experiment a bit to establish the ideal configuration for your
computer.

If you have difficulty configuring the virtual RAM, you will find comprehensive information in your
Windows manual.

Note!

In order to get the game to run well on a slower PC, it’s possible, via the Options Menu, to turn off some
of the more time-demanding elements, e.g. background animations.
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Screen Resolution
In order to make playing D.D.M.C. as enjoyable as possible, three levels of screen resolution are
supported:

• 640x480, 800x600 and 1024x768 Pixels.

The higher the resolution, the larger the play area at your disposal. However, this also means that more
RAM or virtual RAM is used, and under certain circumstances the game may run slower.

Note!

Since D.D.M.C. uses the system extension "WinG" for its fast graphics presentation, it will only run
correctly at a resolution of 256 colours! You should therefore configure your version of Windows
correspondingly.

Music and Sound
The program supports MIDI music and digital sound effects under Windows.

Don’t forget to check that your sound card is installed with the correct drivers and is properly set up. You
should find further information in your sound card’s manual.

Program Installation
To load D.D.M.C., first turn on your computer and run Windows.

Now place the CD-ROM in your PC’s CD-ROM drive.

In Program Manager under Windows use the mouse to select  "File" from the menu.

When the pull-down menu appears, click on "Run“ with the left mouse button.

A window will now appear with a field in which there is a flashing cursor. Type the following text into this
field:

*For Windows 3.11 Play and Windows 95 Play and Installation see Page 32
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[CD-ROM-Drive]:\INSTALL.EXE

For [CD-ROM Drive], enter the letter for your drive.

Normally this will be D or E.

A typical entry might look like this:

D:\INSTALL.EXE

Confirm the entry by clicking on the OK button.

Installation will now start,  copying the necessary files on to your computer’s hard disk and, if required,
installing WinG.

Please follow all the instructions given by the installation program. This should ensure that nothing will
go wrong.

PROLOGUE
A bored young newspaper publisher from  Northampton in England decides to organize a race right
across Europe. The aim of the race is twofold; to travel as fast as possible from city to city, and  to make
as much cash as possible along the way.

He finds his contestants in an exclusive London club, where some of the more aristocratic elements in
Society can frequently be seen whiling away a few hours of their humdrum lives. The assembled ‘ladies’
and ‘gentlemen’ are immediately captivated by the crazy style and persuasive patter of this ‘nouveau
riche’ upstart. Mesmerized, they leap to their feet and, without further ado, rush madly into this great and
unpredictable adventure.

AIM OF THE GAME
D.D.M.C. is a chase right across Europe, in the course of which you have to make as much money as
possible.
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The game is played in several stages, the number of which can be set at the beginning of the game. You
are given a destination city by the referee, and then you try to be the first to arrive there. As soon as one
player has achieved this, the stage comes to an end and a new destination is announced. Of course,
the stage winner receives a handsome reward, so it’s up to everyone to make sure that they’re the one
who crosses the finishing line first!

Once all the stages have been completed, we move on to the crowning climax of the race - the Master
Rally. Before this is reached, all the players are dispersed to various locations throughout Europe. The
player who still has enough breath left to make it to Brussels first wins the Master Prize - so it’s worth
keeping a few cards up your sleeve for this one!

After the Master Rally, the game finishes with the announcement of the overall winner.

The winner is the one who has the largest amount of money. This result is calculated by adding up the
cash in the player’s bank account, together with the value of all the properties he owns.

HOW DO YOU PLAY?
To move your game character (which might be a classy veteran car or an old-fashioned aeroplane), you
first of all ring up your score on a gambling machine (like throwing dice in a board game). You can then
move your character along the road or air route over as many squares as you have points. So, for
example, if you get 5 points, you have to move 5 places. You can’t break the move. It’s up to you,
however, to decide which route you wish to take. But more about that later.

Instead of "throwing the dice“, you might decide to take a feature card. How feature cards work will be
explained later.

Each round - that is, when each player has had a turn - corresponds to one month. As you will soon
discover, the various seasons have a great effect on the progress of the game, so think carefully before
you decide where to move to and when!
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The Controls
The control system in D.D.M.C. has been designed to be as simple and straightforward as possible, so
that even people who have no previous computer operating experience can play the game. You can play
using the keyboard or the joystick as well as a mouse. Depending how many people are playing, you
may decide to use just one of the control methods, or you can use all of them simultaneously if you want.

We recommend playing with a joystick or a joypad with as long a cable as possible. Players can then
sit at a reasonable distance from the monitor and can easily pass the pad or the stick to one another
during play.

Keyboard
Using the cursor keys, you can move the current object in the corresponding direction.

This might be, for example, a menu selection, or one of your game characters.

With the RETURN key (confirmation key), you confirm an action.

With the ESCAPE key (escape key), you can break off from an action.

Joystick / Joypad
• Moving the joystick moves the object in the corresponding direction.

• With the A button (confirmation key), you confirm an action.

• With the B button (escape key), you can cancel an action.

Mouse
Those of you who already have experience of graphical user interfaces should have no problems with
the mouse operation.
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• Use the mouse pointer to select an object.

• With the left mouse button (confirmation key), you confirm an action.

• With the right mouse button (escape key), you can cancel an action.

Examples:

In a selection menu:

• The cursor keys move the active selection in the corresponding direction.

• Confirmation key: The selection is confirmed.

• Escape key: You exit from the menu.

When moving a game character:

Keyboard / Joystick:

• The cursor keys move the game character in the corresponding direction.

• Confirmation key: This accepts the move; the player has then completed the move.

• Escape key: This opens the View Menu from which various representations can be selected.

Mouse:

If you hold the left mouse button down you will see a directional cross. You can now use the mouse
pointer to select the direction in which you want to move. The current choice of direction is shown by
a red arrow. To confirm the move, release the mouse button.

If you have moved the full number of squares during your turn, the ‘confirmation switch’ is activated in
addition to the directional arrows. If you press on this, the complete move is confirmed.
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STARTING THE GAME
D.D.M.C. is started by double-clicking on the corresponding program icon in the Program Manager.
After the introduction, the title screen will appear.

If you press the confirmation key, you will see...

The Start Menu

New Game A new game is started.

Continue Game A game is continued from the point where play
was last halted.

Load Game You may load a previously saved game.

Options This brings up the Options Menu.

Demo This starts a demo of D.D.M.C.

Credits Why not take a look?

Exit Game This ends the program, and you return to the
Windows user interface.

Before we go any further, let’s just take a quick look at...

The Options Menu
The Options Menu allows you to make various changes to make the game work with your system and
to change the form and speed of the game.

To make a change, select the corresponding picture frame and then alter the setting by pressing the
confirm key.



DR. DRAGO’S MADCAP CHASE

13

(1) Turns the music on and off.

(2) Turns the sound effects on and off.

(3) Turns the speech on and off.

(4) Turns the time limit on and off. If you spend too
much time thinking about which direction you
want to travel in, Dr. Drago will start to with-
draw money from your account.

(1) (2) (3) (4)

(5) (6) (7) (8)

(9)

(5) Turns the information about the tourist attrac-
tions on and off. These are distributed over the
play area in the game.

(6) Turns the small animations in the play area on
and off.

(7) Turns the wave animation and the seasons on
and off .

(8) Allows you to turn the joystick on and off.

(9) OK. Your changes are accepted and you quit
the menu.
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OK. Now select „New Game“ in the Start Menu. The first thing you will see is...

The Player Menu
In the Player Menu you can decide how many people are going to take part. You can have up to eight
players racing through Europe at any one time!

To make a change, simply click on the corresponding picture frame.

The pictures of the heads represent the human players (1), the metal heads (2) are computer opponents.
If you see a curtain drawn acoss a frame (3), this means the character is excluded from the game.

You can also enter the name of the player next to each portrait.

(1) (2) (3)

Note!

All the computer opponents have different playing characteristics; you will soon discover against which
opponents you enjoy playing most.
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(1) Play Area. (2) Squares. (3) Player taking his turn. (4) Player’s Feature cards. (5) Information Box.
(6) Current month and year. (7) Player’s Bank Balance. (8) Current destination city and distance from
the current player. (9) Number of moves the player may still make. (10) Player’s current position.
(11) Game characters of the individual players.

There is always a white arrow in front of the player whose turn it is. This shows the direction that the
player should take to reach the destination city by the shortest route.

Note!

Remember, the shortest route is not always the best, so it may not always be a good idea to follow the
arrow!
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THE SQUARES
There are various different colored squares marked on the play area. These are connected by roads,
or by dotted lines which represent air routes.

You can move your game character along any of these routes. Which route you take is up to you;
however, you can travel only from one square to the next. You cannot turn off a route half-way.

 Blue Squares
If your game character lands on a blue square, you win some money.

 Red Squares
If your game character lands on a red square, you lose some money.

 Yellow Squares
If your game character lands on a yellow square, you take a feature card from the pack. Since a player
may not hold more than eight feature cards at any one time, you may have to throw one away before
picking up a new card.

 Purple Squares
If your game character lands on a purple square, you can buy a feature card - provided you have enough
money in your account!
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The rule still holds that a player may not hold more than eight feature cards at any one time, so you may
have to throw one away before buying a new card.

 Gray Squares
Each gray  square represents a town. When your game character is standing on a town, the name of
the town will appear in the information box.

The capital city of each of the different countries is specially marked by its own individual symbol .
Since only capital cities are given as destinations of stages, this might help you to plan your tactics.

You can buy and sell properties and other objects in any town.

Note!

The towns and cities in D.D.M.C. play a significant role in winning the game. You will find details about
this on page 21!

 Tourist Attraction Squares
Various "sights“ of Europe, i.e. famous tourist attractions, can be found over the whole playing area. If
you want to play the tourist, you can interrupt your journey on the corresponding Tourist Attraction
Square and tap the confirm key. A picture of the scene will then appear, together with an explanatory
text. By the way, you won’t lose a turn if you decide to take in some of the sights!
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PLAYING THE GAME
The player whose turn it is has the following options:

Slot Machine
You are shown the number of places you may move, courtesy of the gambling machine, which gives
a number between one and six. You then move your character along that number of places. Your
character moves until it ends on a particular square, and you complete your turn by pressing the Confirm
button.

Note!

Don’t take too long, otherwise you will activate the time limit, and receive an unexpected visit!

Use Card
Instead of moving, you may play one of your feature cards. The functions of the individual feature cards
are described in the Appendix.

Note!

It is important to develop a good knowledge of all the cards and their functions. Only those who know
how to play each card at just the right time will have a chance of being the victor at the end of the game!

Zoom
Enlarges or reduces the representation of the play area.
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Map
This gives you an overview of the play area without moving the game character.

Region
Switching to region mode lets you see at a glance the whole of the play area and the location of each
of the competitors.

Statistics
A window appears in which you can see the towns where you own property. You can change the criteria
by which the list is sorted by pressing the up / down button in the appropriate field.

Main Menu
In the Main Menu, you have the following choices:

Continue Obvious really!

New Game A new game is started.

Save Game You can save the current game.

Takers If one of the other players wants to leave the game, you must select this
menu item. A window will appear in which you must select the correspon-
ding player; this player will then be taken over by the computer! You can
return to the game in the same way!

Options The Options Menu appears.

Exit Game D.D.M.C. now finishes and you return to the Windows main interface.
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If you decide to move, a gambling machine appears which determines the distance you will be allowed
to travel. You can stop the reels at any time with the Confirm button.

During the turn you can hit the escape key to open the Views Menu, which will help you to plan your
move.

THE MONTHLY EVALUATION
Once each player has had a turn, the round, and with it one month, comes to an end. A brief evaluation
for that month then appears, which tells you the current state of play. The player who has the largest
bank balance and is therefore leading the race is shown at the top of the list. Below this, places two to
eight are shown.

Revenue Shows the account transactions of
the past month.

Rent Shows the rental income from the
past month.

Account The player’s current balance.

Assets Shows the overall value of the
player’s assets.
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TOWNS AND PROPERTIES
Towns are a very important factor in D.D.M.C. It is only in the towns that you can buy and sell properties.
Each of these properties provides a monthly rent for you, so if you own some properties you will always
have a regular source of income.

However, if you end up in the awkward situation of having a negative bank balance, you will have to sell
some of your properties, enough at least to bring you back into the black! So make sure you always have
a decent balance in your account!

There are six different types of properties:

Agricultural Properties
These are properties which yield agricultural produce.

In general they are not very expensive; however, they don’t provide a very high average
rental income.

One advantage of agricultural properties is that you are NOT forced to sell them if you
get into financial difficulties.

A disadvantage is that they are very susceptible to drought. If the weather gets too hot,
you will find your investments melting away.

Industrial Properties
These properties are quite expensive, but they do produce a good income. Industrial
properties are, by and large, fairly safe risks, but can be lost through flooding or “hungry
people”.
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Trade Properties
Trade properties represent a “safe“ investment for people who enjoy a little wheeling and
dealing. Available at various price levels, they offer correspondingly varying incomes.

Problems might start if the industry in the locality can no longer produce goods. If an
industrial property in a district is hit by some catastrophe, then trade is also affected.

One particular person - need we say who? - is particularly fond of “re-possessing“ trade
properties!

Risk Properties
The name says it all. Owning these properties can be risky - you never know just what
might happen to them!

However, the rental income of these risk properties is extremely high - that is, so long
as they don’t get messed up by a certain event.

Luxury Properties
These are properties that you always wanted to own, but never dared buy! Expensive
and unnecessary - but you may need them later.

Your friend Dr. Drago loves these properties!

Other Properties
These are properties that, as a rule, you can get hold of quite easily. That is, as long as
somebody else doesn’t get there first...
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THE PROPERTIES OVERVIEW
If your turn lands you on a city, an overview of all of the town’s properties that are available for purchase
will appear.

On the left of each row you will see the name of the owner, if there is one.

Next to this is the symbol for the type of property. The color of the frame of each individual symbol tells
you whether a player has secured a monopoly in this locality. If this is the case, the frame will be golden.

There then follows a description, together with the price and monthly rental income. This shows both
the gross value in $ and the yearly income as a percentage of the buying price.

Now, if you have enough spare cash, you may buy a property. You may also sell whatever properties
you already own. This might be a good idea if you wish to top up your bank balance. However, hardly
anyone will offer you the full price for them...

Buy
To buy properties, select the menu item “Buy.” You can now buy all the properties that are not already
owned and for which you have sufficient funds.

Once you have selected a property, your portrait appears immediately in the corresponding place. This
makes it clear that, from now on, you are the rightful owner.

Sell
Selling works in the same way as buying.

Of course, you can only sell properties that you actually own.
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Card
There are different  “Feature Cards”  which influence the price and the ownership of properties. If you
own one of these cards, you can play it by selecting the appropriate menu item.

Return
You quit the properties overview and at the same time end your turn.

THE MONOPOLY
Should you succeed in buying all the properties in a town, then you become a monopolist, and you will
also receive double rent on all the real estate you own there!

Since a monopoly is a sure-fire and popular way of earning loads of money, you should always be trying
to set up as many monopolies as possible. And, of course, you should be doing your best to prevent your
fellow players from doing the same.

Note!

In general, it’s better to build up a monopoly based on expensive properties rather than distribute your
wealth thinly over lots of cheaper ones.

AND THEN THERE’S....

Dr. Drago
Dr. Drago is a mad-cap character who’s always hot on the heels of the player furthest from the
destination city at the end of each stage.

His greatest pleasure is finding ways of sabotaging his victims’ chances.
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Dr. Drago has equipped himself with various vehicles to pursue you. The vehicle he chooses at any
particular time also gives you a clue to his current mood.

Bicycle

If he’s riding his bike, this suggests that Dr. Drago is in a good mood and will not be inflicting too much
harm on his victim.

Automobile

If Dr. Drago’s driving his car, he won’t be in a very good mood, so you should do your best to shake him
off.

Zeppelin

If he’s charging around in his Zeppelin, you can be sure that Dr. Drago has got it in for someone! If you
don’t have any means of protecting yourself from him at this point, you can wave Goodbye to your
chances of victory!

If you aren’t too keen on having an unpleasant character like Dr. Drago on your tail, here are a few tricks
you can use to get rid of him:

• You can be the lucky owner of the right feature card.

• You can pass him on to another player by moving your character on to or over a place where another
player’s character is located.

• You can wait until the next finishing line is crossed and make sure that there’s someone else further
away from the destination than you are.

Note!

It’s not a good idea to overtake a player who has Dr. Drago sitting on their tail!
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Events
From time to time, various events may take place which can disrupt the whole course of the game. For
example, a flood might ruin your property, a rock fall might block the road, strange figures might appear,
etc. etc.

Always try to make sure that you’re insured against these unforeseen circumstances!

Border Posts
You’ll notice that at the beginning of the game the roads into the eastern part of Europe are blocked off
by border posts.

But don’t worry - in the course of time this is bound to change!

Audit
At the end of each year the race organizer carries out an audit to see how the individual players are
getting on. At the same time, an inflation rate is set, which makes everything a little more costly.
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THE FEATURE CARDS

Taxes

Send the tax man after
another player.

Account

The sum of all accounts is
divided between players. As
a result everyone has the
same amount of money.

Zero

Clear all your debts and
brings your account to zero.

Credit

Buy now and pay later for
your purchases.

Purchase

The player can buy
properties off of another
player in a city (used to gain
a monopoly in a city).

Rent

Use this card to get rent from
another person's property
for one year.

Take

Use this card to confiscate
one property from another
player.

Debts

Transfer  your debts to
another player.

Platinum

Use this card to buy any of
the properties in a city for
10% of the normal price.

Sell

Use this card to sell your
property at one and a half
times more than its normal
price.

Buy

Use this card to buy any of
the properties in a city for
75% of the normal price.

Gold

Use this card to buy any of
the properties in a city for
50% of  the normal price.

Christmas

Use this card to get a present
from Santa in the month of
December.

↓ FINANCES ↓
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4 Reels

The player gets a s lot
machine with 4 reels.

5 Reels

The player gets a s lot
machine with 5 reels.

Flight

Allows you to fly to or closer
to your destination.

1 or 2

The player gets either a one
or two space move.

1 Space

The player can move one
space.

3 Reels

The player gets a s lot
machine with 3 reels.

2 Reels

The player gets a s lot
machine with 2 reels.

↓ MOVEMENT ↓

Goodbye

This will send another player
off on a trip either further
away or closer to the final
destination.

Punch

Use this card to punch the
player behind you off the
road.

Conference

This will bring everyone to
where you are.

Nails

Throw nails on the road and
block the others behind you
from passing.

Earthquake

All property in a city gets
destroyed.

Sleep

Send another player to sleep
and get them to miss a turn.

Block

Stops another player from
using their feature cards for
one round.

No Steering

Sabotage another player’s
steering and get them to
miss a turn.

Sugar

Sugar another p layer ’s
engine and get them to miss
a turn.

↓ DISRUPT ↓
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↓ VARIOUS ↓

Snowplough

Snow and water that are
blocking the road can be
cleared.

Insurance

The player is automatically
insured against  natural
disasters.

Clear Nails

Nails on the road are cleared
away.

Nessie

The player is automatically
insured against damage
incurred by Nessie, the Loch
Ness Monster.

Push Off

Use this to get rid of Dr.
Drago and send him to
another player.

↓ INSURANCE ↓

3 Spaces

The player can move three
spaces.

4 Spaces

The player can move four
spaces.

5 Spaces

The player can move five
spaces.

6 Spaces

The player can move six
spaces.

2 Spaces

The player can move two
spaces.

Gamble

With a little luck, the player
can multiply the points he’s
obtained.

Double

The player can use a card
without having to turn it to
the deck.
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LIMITED WARRANTY
90-day Warranty and Software License Agreement

Play Byte Software, Inc. warrants that the media on which this software program is recorded will be free from defects in materials and
workmanship, under normal use for a period of 90 days from the date of original purchase. Defective media which has not been subjected to
misuse, excessive wear or damage due to carelessness, may be returned during the 90-day period for free replacement—provided you
have previously returned your product registration card to Play  Byte Software, Inc.

This computer software product (the “Software“) and user manual are provided to the Customer under license from Play Byte Software, Inc.
and are subject to the following terms and conditions, to which the Customer agrees by opening the package of the Software and/or using the
Software. Granting of this license does not transfer any right, title or interest in the Software or user manual to the Customer except as
expressly set forth in this License Agreement. The Software and user manual may not be duplicated or copied for any reason. The Customer
may not transfer or resell the Software or user manual. The remedies provided above are the Customer’s sole and exclusive remedies.

In no event shall Play  Byte Software be liable for any direct, indirect, special, incidental or consequential damages with respect to the
Software or the user manual. Except as provided above, Play Byte Software makes no warranties, either expressed or implied, with respect
to the Software or user manual, and expressly disclaims all implied warranties, including, without limitation, the warranty of merchantability
and fitness for a particular purpose.

Copyright
© 1997 Play Byte Software, manual, text, graphics, and names copyrighted. All rights reserved. No part of this publication may be reproduced,
sent, transmitted, or translated into another language, in any way, without written authorization from Play Byte.

Trademarks
“Dr. Drago’s Mad Cap Chase”  is a trademark of Play Byte Software Inc.  “MICROSOFT”, “WINDOWS”,  and “MS-DOS” are registered
trademarks of the Microsoft Corporation in the United States and other countries.

All other product names used in this manual are registered trademarks of the respective manufacturers.
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To play under Windows 3.11 :
Turn on your computer and start Windows. If you made a program icon double click on that, then
double click on the D.D.M.C. icon to play. If you decided not to make a program icon, double click
on the program manager. Select the hard drive to which you installed the game. Double click on the
Bluebyte folder, then the Drago folder and then the Rally icon to play.

To install under Windows 95:
Turn on your computer and start windows.  Click on the start icon in the lower left corner of the
screen. Click on run and type in the following : {Cd-Rom drive}:\install.exe
For {Cd-Rom drive} enter the letter for your drive. Normally this will be D: or E:
A typical entry will look like this D:\install.exe
Confirm the entry by clicking the O.K. button. When the Dr. Drago’s Madcap Chase screen appears
select install. Click on O.K. to start copying the game files. Follow the instructions given by the
installation program.

To play in Windows 95:
If you created a program icon click on start, then programs, then D.D.M.C.,and then D.D.M.C again.
If you decided not to make a programs icon. Double click on my computer, select the hard drive that
where the game is installed. From there you need to double click on the Bluebyte folder, then the
Drago folder, and finally the Rally icon.
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